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 RefWorks is a Web-based product that you can use to create your own personal 
bibliographic database, either by importing references from online databases or by 
entering them manually.  You can then use these references in writing papers, and you 
can automatically format and reformat the paper and bibliography in different styles in 
just seconds.  RefWorks can be used in Windows, Macs, or Unix.  RefWorks works in 
much the same way as EndNote, ProCite and similar reference management products, 
but because it is Web-based you can access it anytime and anywhere you have Web 
access.   
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Registering for an Account  
 
UMass has an institutional subscription.  You must be a student, staff, or faculty of 
UMMS/UMMHC—check with the Library Service Point at 508 856-6099 or 
refstaff@umassmed.edu for directions to register for an account. 
 
 
Circled portion below indicates what you will be using to navigate: 
 

 
Building your RefWorks Bibliography 
 
Start with the first button along the top, References, then “Add New Reference” from 
the drop down box: 
 

Entering references manually: 

• Select an Output Style under View fields used by, then Access Output Style 
Manager; a long drop-down list is provided. Choices include general styles such 
as APA and AMA, and those of specific journals such as Nature and the New 
England Journal of Medicine.  Selecting one does not lock you into that style 
forever; you will be able to change styles and reformat your papers at will.   

 
• Choose the type of reference you are entering – there is a drop-down list 

including journal, conference proceedings, web page and more. The default is 
Journal but the fields for other types will be different, so be sure to select the 
right one.  
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• Note that some fields are marked with a √.  If you click the √, it will show you 
more information about “fields used by….”.  On the right there are also 
explanations of required formats for some entries; sometimes there is also a link 
giving details about the appropriate format for the style you have chosen. 

 
• Enter information manually or by cutting and pasting. 
   
• Place the new reference directly into a folder if you have any set up, but it is not 

obligatory.  You can set up folders and move references into them at any time. 
 
• Once you have entered all the information, click on Save Reference at the top.  

It will save and reappear with a number. If something is entered incorrectly, it will 
tell you. 

 
• To enter more references, click on References – Add New Reference in the 

toolbar along the top. 
 
Importing references: 
 
Along the top click on Import under REFERENCES:  

• Import instructions—provides instructions for importing references into 
RefWorks from specifics databases. 

 
• List of Filters and Databases is a list of the databases that support Direct 

Export to RefWorks. 
 

• Request a Filter - if you find a database or journal that is not supported, you can 
suggest that it be added. 

 

Getting references from an Online Catalog or Database: 

• Search – Online Catalog or Database (You can search PubMed here which 
is easier than importing a text file); scroll to the desired database. Use either 
Quick or Advanced Search to find references, and select any you want to add 
to your bibliography by putting checks in the Ref ID boxes. Click Import. If 
desired, choose the folder into which to import the references. RefWorks will ask 
if you want to import the references; once you click OK it will import them and 
you can close the search window.  

 
• You should ALWAYS check to be sure the reference(s) were imported correctly! 

Do this by choosing View Last Imported Folder. If it didn’t work, go to the online 
Help - Checking for Errors. 

Getting references directly from a Database: 
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An option that may be available in some online databases is Direct Export.  

EBSCO:  

For Direct Export: 

1. Conduct a search.  

2. Click on the Add folder icon to the right of any results you want to save.  

3. Click on the Folder has items link, above the Results List on the top of the 
screen.  

4. Click on Export.  

5. Click the radio button in front of Direct Export to RefWorks to initiate a direct 
export. 

Note: Uncheck the Remove these items from folder after saving option, if you want 
items to remain in the folder after performing the export function.  

7. Click the Save button to begin the direct export. 

8. Your records should appear in the Last Imported Folder. 

OVID: 

For Direct Export: 

1. Select the references you want to export. 

2. Under Results Manager on the left, select Complete Reference in the Fields 
section. 

3. Select the Direct Export under Results Format. 

4. Click the Save button. 

5. Select Export Citations to RefWorks and Continue. 

6. The export will open RefWorks if it is not already open and automatically import 
the references.   

7.  Your records should appear in the Last Imported Folder. 

Importing Text Files:  
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PubMed 
There are two ways to import files from PubMed.  The method immediately below is the 
easiest. 
 

1. Select Search in the bar at the top. 
2. Select Online Catalog or Database. 
3. Then Online Catalog or Database to search, choose PubMed from the drop 

down box. 
4. Construct a Quick Search or an Advance Search and when the download is 

complete, put a check in the box for the references that you would like to import. 
5. Click Import. 

OR: 

1. Go directly to PubMed and perform a search in PubMed, then mark the 
references you want to export. 

2. Change the Display option from Summary to MEDLINE. 

3. In the Send To drop-down, select Text.  A window opens with just the 
references in MEDLINE format.   

4. Select Save As from your browser and select Text as the Save As file type.  

5. Save file to desktop (or to where you can find it easily). 

6. Log in to RefWorks. 

7. Select References/Import from the toolbar. 

8. Select NLM PubMed as the data source and as the database. 

9. Browse to find the text file you saved to your computer. 

10. Click Import. 

11. Your records should appear in the Last Imported Folder.   

 

Moving References from Endnote to RefWorks 

RefWorks has a feature that will allow you to upload your library from EndNote (versions 
8 and newer) directly into RefWorks.  
 
Note: If you want to import a large number of references, it is recommended that you 
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import no more than 2500 records (or 3MB of files) at a single time.  
 
 Log into your RefWorks account, and from the References menu select Import 
EndNote V8+ Database. 
 

 

 

Browse for and select your EndNote library (.enl).   Specify a folder to import your 
records into (optional). 

 

Click on Import at the bottom of the Import window. The progress in importing is 
measured by * for each reference imported. RefWorks will notify you when the import is 
complete. Your records should automatically appear in the Last Imported folder. 

 

Moving References from RefWorks to Endnote 
 

http://www.endnote.com/support/Faqs/Import/faq13.asp 

http://www.endnote.com/support/Faqs/Import/faq13.asp�
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How can I transfer references from RefWorks into EndNote? 
 
 

1. Creating a formatted text file in RefWorks  

a. In your RefWorks account, go to the References menu and choose Export. 

 

 

 

b. Select the references you want to export (e.g., All, or by folder), verify the 
Bibliographic Software button is selected and click the Export to Text File button.  

 

c. The next screen confirms the export is processing.  
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d. A new Web browser window opens with your references presented in a 
structured format. If the references do not appear in a new Web browser window 
automatically, click the Download It link.  

      

 

e. Save your references to a text file on your desktop by selecting the File menu 
and Save As.  
Note: remember where the file is located for importing into EndNote. 
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f. Now you are ready to import your references to EndNote. 

 

============================================================ 

2. Import the text file into EndNote 

a. Create a new EndNote library, or open an existing one to import the text file. 

b. From the EndNote File menu, choose Import. 

       

 

c. Click the Choose File button to locate the file saved from your RefWorks 
account. 
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d. On the Import Option drop-down list, choose “Reference Manager (RIS)."  The 
selections for Duplicates and Text Translation do not require adjusting unless your 
operating system is using a language setting other than English. 

       

 

e. Click on the Import button. EndNote will present your references in a library 
window. You can view all references in a library by selecting the References menu 
and Show All References. 

 
 
 
Writing your Paper:  
 
There are two ways to insert references from your RefWorks bibliography into a paper. 
The simplest is using Write-N-Cite, a tool that you download. Write-N-Cite then resides 
in your Microsoft Word Tools, and you use it whenever you want to insert a citation.  
When you are all done, you format your paper and its bibliography in the Style you 
choose (APA, JAMA, Nature, etc.) and it is formatted into a new document. You can 
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save the new document, but you should also save the original so you can edit it or 
reformat it in a different Style if desired. 
 
Write-N-Cite: 
 

• First, download the Write-N-Cite tool; Under the Tools tab, choose Write-N-Cite.  
The download screen will come up; click on the link and the Write-N-Cite utility 
will be installed on your computer.  It doesn’t take long as it isn’t very big, and 
having it will simplify writing and formatting papers. 

 
• (Note: If you are working here in the library on a UMass computer, you can install 

Write-N-Cite temporarily, or you can put it on your H: drive.) 
 
• Open your Word document.  At the point where you want to insert a citation, 

open Write-N-Cite by selecting it from Word’s Tools drop down menu.  Log in to 
RefWorks.  

 
• Your entire RefWorks bibliography will open.  Here’s where having Folders is 

handy. Choose View, and then select the appropriate folder. 
 
• Scroll to the desired citation and click on Cite. 
 
• The citation will be in double curly brackets {{ }} with just the number of the 

reference in your RefWorks bibliography and the author’s last name and first 
initial.  This coding is what gives RefWorks the flexibility to reformat your paper in 
different styles at will. 

 
• Keep Write-N-Cite open as you continue to write your paper, inserting 

references as needed. 
 
• When you are finished with your paper, save it and close it.  Close Write-N-Cite.  

Go back to RefWorks and click on the Bibliography tab along the top.  
  
• Choose Format Paper and Bibliography. 

 
• Browse to choose the paper. 

 
• Click Create Bibliography at the bottom.  
  
• RefWorks will process your paper in the format you chose.  You may need to 

download it – just click as directed – and the paper will open in a separate 
window.  You can also save or email it. 

 
• Note that your paper is saved in a different version than the original – it will be 

titled final-[your title].  This preserves your original so you can continue to edit 
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and reformat it at will.  You can save the new version, or you can just close it and 
keep working on the original. 

 
• To change the style of your paper, simply choose a new style from the drop-

down menu on the Bibliography page and proceed as above.  Presto! 
 
One Line One Cite: 
 
If you really don’t want to download the Write-N-Cite tool, you can insert references 
directly from RefWorks.   
 

• From your RefWorks Bibliography, or from the appropriate folder in your 
Bibliography, click on Switch to: One line/Cite View.  You will then be looking at 
your references in a slightly different interface.   

• On the left there will be a box for selecting the reference; then there are links to 
Cite or View.  Click on Cite. 

• A box will come up with the selected citation(s) in a Citation Viewer.  Click Select 
Citation. 

• Now you must copy and paste the citation into your paper.   
• If you want to insert more than one citation, you need to click on Cite for each 

one, then copy and paste the entire list into your document. 
• When you are finished, you can format the paper and bibliography as above. 
 

Folders 
 
Folders make it easy to organize your RefWorks bibliography.  To set up folders: 

• In the toolbar at the top, click on Folders – Create New Folder.   
• Give your folder a name and click Okay. 

 
Now you can put existing references into your folder(s), or you can add them to folders 
as you import them.  Also, you can Organize Folders and Rename them, Delete them 
or Clear them.  You can also look at their contents by just clicking on the number of 
references in the folder. Organize Folders is also found under References. 
 
Note that there is a Last Imported folder; this contains the last references you imported 
even if you put them directly into a folder. You should always check this folder after you 
import any references. 
 
RefWorks also tells you how many references you have altogether and how many, if 
any, are not in folders.  If you decide they should be in folders, click on X reference[s] 
is[are] not in a folder. It will take you to those reference(s) and you can choose Put in 
Folder in the gray bar – the drop-down menu shows you your folders and you can 
choose the appropriate one. 

http://www.refworks.com/Refworks/RefList.asp?M=3&T=75,110,101,101,32,105,110,106,117,114,105,101,115�
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Other Options and Notes:  
 
1. A new tool is RefGrab-It, which allows you to directly import information about a 
website into your RefWorks account. Find it under Tools – RefGrab-It and download it 
(it’s a very small program). It puts an icon in your toolbar; simply click the icon whenever 
you are in a website that you want to add to your RefWorks account and it will capture 
the bibliographic information. If you then decide to import the data, you can simply click 
to do so automatically if your RefWorks account is open; otherwise it will ask you to log 
in. If there is an ISBN number, PubMed ID or DOI on the web page, RefGrab-It will 
automatically search various web resources to get supplemental information that may 
be of interest. RefWorks may also locate RSS feeds related to that web page. 
 
2. Whenever you are looking at references, note that you have several choices in the 
gray bar:  Delete; Put in Folder; Add Descriptor; Global Edit; and Print.  You can do 
this to just the references you Select by clicking in the little box at the top left of each 
reference, next to its ID number; or you can choose the whole Page; or All in List, 
which means all the references in the list you are currently viewing (e.g., in a folder). 
 
3. Another option is to find and eliminate duplicates. RefWorks isn’t very good at sorting 
out duplicates when you first import them, so you will want to check occasionally.  
Under View in the gray toolbar, choose Duplicates and then either Exact Match or 
Close Match. Choose Close Match; it will show you all probable duplicates and you 
can select the better reference and delete the other. (Usually the references will be 
exactly the same, but sometimes one may have more detail than the other.) 
 
4. Note that whenever you delete a reference, its number disappears and will not be 
reused.  Therefore, reference ID numbers do not reflect the actual number of references 
in your database (unless, of course, you never delete any). However, RefWorks always 
tells you exactly how many references you have, so you can just look at that number. It 
appears on every reference; e.g., “Journal Reference 152 of 172,” so you know you 
have 172 total references in your database). 
 
 
5. You can easily Search your database. In the toolbar along the top, click on Search, 
then choose Advanced (which allows you to search by fields or in folders); Lookup by 
Author, Descriptor, or Periodical; or you can Search by Online Catalog or Database 
and limit your search to the source from which you got the reference(s). 
 
 
 

If you have any questions about using RefWorks, email 
refstaff@umassmed.edu  

mailto:refstaff@umassmed.edu�
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